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Copyright 
Copyright (C) 2003 PLANET Technology Corp. All rights reserved.  

The products and programs described in this User ’s Manual are licensed products of PLANET 
Technology, This User’s Manual contains proprietary information protected by copyright, and 
this User’s Manual and all accompanying hardware, software, and documentation are copy-
righted.  

No part of this User’s Manual may be copied, photocopied, reproduced, translated, or reduced 
to any electronic medium or machine-readable form by any means by electronic or mechanical. 
Including photocopying, recording, or information storage and retrieval systems, for any pur-
pose other than the purchaser's personal use, and without the prior express written permission 
of PLANET Technology. 

 
Disclaimer 
PLANET Technology does not warrant that the hardware will work properly in all environments 
and applications, and makes no warranty and representation, either implied or expressed, with 
respect to the quality, performance, merchantability, or fitness for a particular purpose. 

PLANET has made every effort to ensure that this User ’s Manual is accurate; PLANET dis-
claims liability for any inaccuracies or omissions that may have occurred. 

Information in this User ’s Manual is subject to change without notice and does not represent a 
commitment on the part of PLANET. PLANET assumes no responsibility for any inaccuracies 
that may be contained in this User ’s Manual. PLANET makes no commitment to update or keep 
current the information in this User ’s Manual, and reserves the right to make improvements to 
this User’s Manual and/or to the products described in this User ’s Manual, at any time without 
notice. 

If you find information in this manual that is incorrect, misleading, or incomplete, we would 
appreciate your comments and suggestions. 

 
CE mark Warning 
The is a class B device, In a domestic environment, this product may cause radio interference, 
in which case the user may be required to take adequate measures. 

 

Trademarks 
The PLANET logo is a trademark of PLANET Technology. This documentation may refer to 
numerous hardware and software products by their trade names. In most, if not all cases, these 
designations are claimed as trademarks or registered trademarks by their respective compa-
nies. 
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Chapter 1 
Introduction 

This Chapter provides an overview of Internet Camera 's features and 
capabilities. 

Internet Camera provides a low cost solution for enterprise and SOHO users to en-
hance the ability of network environment. By connecting directly to an Ethernet or Fast 
Ethernet, the high quality video image can be monitored everywhere. The main differ-
ence from the conventional PC Camera is that Internet Camera is a standalone system. 
There is no need to attach another computer with Internet Camera like usual PC 
cameras do.  Via a web browser, Internet Camera can be managed, accessed and 
controlled remotely over the Intranet or Internet. Management can be more efficient 
and relative cost will be reduced by this way. 

ICA-100/ICA-100W Features 
Internet Camera includes many advanced features, which are designed to provide 
powerful functions while being easy to use. 

Vivid Your Website. 
Live-images on web site is a new trend of Internet nowadays. Must websites always 
be immutable and frozen with only text and static pictures? Add ICA-100 series to 
make websites more vigorous. 

User-friendly Interface.  
Internet Camera supports both ActiveX mode for Internet Explorer and Java mode 
for Internet Explorer and Netscape Navigator. The only requirement for configuration 
and image viewing is a web browser software such as Internet Explorer 5.0 or above 
or Netscape 6.0 or above. Via user-friendly web interface, even a beginner with less 
knowledge about network can manage easily. 

Remote Monitoring and Management.  
ICA-100 series can fully integrate with your network. By the conveniences of world 
wide Internet, you can do the monitoring anywhere. Via add-on utility, network adminis-
trators can decide whether individuals or the whole team may access ICA100 series. 
Multi-user password protection support offers more flexibility while managing ICA100 
series. 

Alarm Trigger Function.  
Adding external sensors to the auxiliary I/O connecter of ICA-100 series can let you 
program event-based notification to fit various security demands. Internet Camera can 
connect up to two input and two output external devices. 

DDNS Support 
Internet users can access the live images with a DDNS registered hostname instead of 
knowing camera’s real IP address. 
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Motion Detection 
Monitor any suspicious movement in a specific area. 

Wired and Wireless Network Support.(ICA-100W only) 
ICA-100W provides both wired and wireless function. You can use ICA-100W in differ-
ent LAN environment by simple mode switching. 

Package Contents 
The following items should be included: 

• Internet Camera unit 
• Camera Stand Accessory 
• Power Adapter 
• CD-ROM 
• Quick Installation Guide 
• Wireless Antenna*2 (ICA-100W only) 

If any of the above items are damaged or missing, please contact your dealer immedi-
ately. 

 

Physical Details 
 
Front Panel 

 

                           Power LED 

                                                                                                                          LAN LED 
 

 

 

 

 

 

 

Figure 1-1: Front Panel 
Power LED 
The Power LED is positioned on the right side of ICA-100 series’s lens while facing 
ICA-100 series. Steady blue confirms ICA-100 series is powered on. 
LAN ( /WLAN ) LED 
The LAN ( /WLAN ) LED is positioned on the far right side of ICA-100 series’s lens 
while facing ICA-100 series. It is located right of the Power LED. Steady orange con-
firms good connection to LAN or WLAN connectivity. Dependent on the data traffic the 
LED will begin to flash to indicate ICA-100 series is receiving/ transferring from/to the 
LAN or WLAN network. 
Note: 



Introduction 

3 

There are three settings for the Power and LAN ( /WLAN ) LED to control the light 
illumination for monitoring purpose from Normal / Off / Dummy. Please refer to the 
Web Configuration section for detailed information and usage. 
 
 
Rear Panel 

 
Figure 1-2: Rear panel of ICA-100 

 
Figure 1-3: Rear panel of ICA-100W 

Network Cable Connector 
Internet Camera provides an RJ-45 connector for connections to 10Base-T Ethernet 
cabling or 100Base-TX Fast Ethernet cabling (which should be Category 5 twisted-pair 
cable). The port supports the NWay protocol, allowing ICA-100 series to automatically 
detect or negotiate the transmission speed of the network. 
DC Power Connector 
The DC power input connector is located on ICA-100 series’s rear panel and is labeled 
DC 5V with a single jack socket to supply power to ICA-100 series. Power will be 
generated when the power supply is connected to a wall outlet. 
Reset Button 
Reset will be initiated when the reset button is pressed once and Power LED begins to 
flash.  
Factory Reset of ICA-100: Press the reset button for three seconds or until Power LED 
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begins to light up, then release the reset button and the Power LED will begin to flash 
indicating ICA-100 is changing to factory reset. When factory reset is completed the IP 
address will return to the default setting as 192.168.0.20. 
Factory Reset of ICA-100W: Press the reset button for three seconds or until Power 
LED begins to light up, then release the reset button and the Power LED will begin to 
flash indicating ICA-100W is changing to factory reset. When factory reset is com-
pleted ICA-100W will be set to default on channel 11 and EES-ID is set as “NULL 
String” (This default setting will let ICA-100W able to connect ANY access point on the 
infrastructure network). The IP address will also return to the default setting as 
192.168.0.20. 
 
I/O Connector 
There are four I/O connectors, two for input and two for output situated on the rear 
panel. The I/O connectors provide the physical interface to send and receive digital 
signals to a variety of external alarm devices. Please refer to the User’s Guide appen-
dix for detailed information. 
 
Slide Switch( ICA-100W only) 
The slide switch permits user to determine the type of network communication media 
for ICA-100W and is positioned on the rear panel. The three settings are as follows: 
· LAN (Local Area Network) 
· LAN/WLAN (Local Area Network/Wireless Local Area 
Network) 
· WLAN (Wireless Local Area Network) 
 
Antenna Connector( ICA-100W only) 
There are two Reverse Polarity SMA type antenna connectors located at the rear panel 
of ICA-100W providing connection for two high sensitivity antenna included with the 
device.  You can also install the antenna with higher dB gain to get longer distance 
connection.  However, only antenna connector above the DC power connector is used 
to transmit wireless signal.  Thus, only connect the high dB gain antenna to this con-
nector. The other one should still connect with bundled antenna. 
 
Top Panel 

 
Figure 1-4:Top Panel of ICA-100 
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Figure 1-5:Top Panel of ICA-100W 

 
Screw Hole 
Located on the top panel of ICA-100 series, the screw hole is used to connect the 
camera stand onto ICA-100 series by attaching the screw head on the camera stand 
into the screw hole of ICA-100 series. 
 
Bottom Panel 

 
Figure 1-6 Bottom Panel 

Screw Hole 
Located on the bottom panel of ICA-100 series the screw hole is used to connect the 
camera stand onto ICA-100 series by attaching the screw head on the camera stand 
into the screw hole of ICA-100 series. 
 
.
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Chapter 2 
Installation 

This Chapter covers the physical installation of ICA-100 Series. 

Requirements 

 ICA-100 ICA-100W 

Network Environment 

LAN 10/ 100M Ethernet 10/ 100M Ethernet 

IEEE 802.11b Wireless LAN 

Monitoring System Recommended to Access ICA-100 series 

System Hardware • CPU: Pentium II, 266 MHz or above 

• Memory Size: 32 MB (64 MB recommended) 

• VGA card resolution: 800x600 or above 

Web Browser • Internet Explorer 5.0 or above (ActiveX & JAVA Mode – 
Image View for Windows OS and JAVA Mode – Image 
View for other OS) 

• Netscape 6.0 or above (JAVA Mode – Image View) 

System Requirement for IPView Application 

Support OS Win 98, Win 98 SE, Win 2000, Win Me, Win XP 

System Hardware • CPU: Pentium III, 450 MHz or above 

• Memory Size: 128 MB (256 MB recommended) 

• VGA card resolution: 800x600 or above 
 

Connecting ICA-100 series to the Camera Stand 
ICA-100 series comes with a camera stand accessory with a swivel ball screw head 
that can be attached to ICA-100 series 's top or bottom screw hole. Attach the camera 
stand to ICA-100 series and station it for your application. There are three holes lo-
cated in the base of the camera stand allowing ICA-100 series to be mounted on the 
ceiling or any wall securely. 
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Figure 2-1: Camera Stand 

Hardware Install Procedure 
 

ICA-100 

1.Connect an Ethernet cable 
Connect one end of an Ethernet cable to the LAN port located on the ICA-100 rear 
panel and attach the other end to the network device (hub or switch). 

 
2.Attach the external power supply 
Connect the provided power adapter to the ICA-100’s connector labeled "5VDC" on 
rare panel.  
 
3.Check the LEDs 
The PWR and ACT LEDs should be on. 
 
ICA-100W 

1.Attach Wireless Antenna (LAN+WLAN or WLAN mode) 
Screw the 2 external Antenna provided into the antenna connector located on ICA-
100W’s rear panel. 
2.Connect an Ethernet cable (LAN or LAN+WLAN mode) 
Connect one end of an Ethernet cable to the LAN port located on the ICA-100W’s rear 
panel and attach the other end to the network device (hub or switch). 
3.Switch to appropriate network type 
Select the desired Network communication type for ICA-100W from the Slide Switch. 
Position the Slide Switch to the setting required. 
4.Attach the external power supply 
Connect the provided power adapter to the ICA-100W’s connector labeled "5VDC" on 
rare panel.  
5.Check the LEDs 
The PWR and ACT LEDs should be on. 
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Chapter 3 
Configuration 

This Chapter provides details of the software configuration process. 

Login 
ICA-100 series must be configured through its built-in Web-based Configuration. 
Extensive knowledge of LAN will be helpful in setting up. From the web browser, type 
http ://192.168.0.20 in the address box to access Home page of ICA-100 series. 
 

If you can't connect 
If ICA-100 series do not respond, check the following: 
• Machine is properly installed, LAN or WLAN connection is OK, and it is 

powered ON. You can test the connection by using the "Ping" com-
mand: 
• Open the MS-DOS window or command prompt window. 
• Enter the command: 

   ping 192.168.0.20 
If no response is received, either the connection is not working, or 
your PC's IP address is not compatible with ICA-100 series’ IP Ad-
dresses. (See next item.) 

• Ensure that your PC is using an IP Address within the range 
192.168.0.1 to 192.168.0.254 (excluding 192.168.0.20).  
Also, the Network Mask should be set to 255.255.255.0 to match ICA-
100 series. 
In Windows, you can check these settings by using Control Panel-
Network to check the Properties for the TCP/IP protocol. 

 
Home Page 
After the default IP address is entered from the browser, the Home page will appear 
with a still image. There will be three options to choose from to set-up and view your 
Internet Camera and they are as follows: 
• View Image – ActiveX Mode 
• View Image – Java Mode 
• System Administration 
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Figure 3-1:Home Page 

System Administration 
Click on “System Administration” from the Home page to access the settings re-
quired for ICA-100 series. There will be several options in the menu bar to choose 
from to set your Internet Camera and they are as follows: 
• System 
• Image 
• Users 
• DateTime 
• Trigger 
• Upload 
• Information 
• Tools 
System 

The System menu contains commands for settings that are required for inputting key 
details to set-up ICA-100 series for operation. 

Click on "System" in the system administration menu bar and the System screen will 
appear. The screen below is from ICA-100W; the screen of ICA-100 is the same but 
has no “Wireless Interface” parameters. 
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Figure 3-2: System Screen of ICA-100W 
Camera Name: 
This field is used for entering a descriptive name for the device. The default setting for 
the Camera Name is CS-xxxxxx, where xxxxxx is the last six digit of the MAC Address. 
The maximum length is 32 (Printable ASCII). 

Location: 
This field is used for entering a descriptive name for the location used by ICA-100 
series. 

Admin: 
This field is used for entering the Administrator ID along with the password to access 
the System Administration settings. Be sure to enter the password twice to confirm the 
details once in the Admin Password field and again in the Confirm Password field. The 
default setting for Admin is blank space (Null String) you need to key in the Admin ID 
with a maximum length of 12 (Printable ASCII) characters and enter the Admin Pass-
word with a maximum length of 8 (Printable ASCII) characters. Please note that Admin 
ID and Admin Password must be set before using IPView utility to connect Internet 
Camera; otherwise the Internet Camera can not be added to IPView. 

IP Assignment: 
There are two options to select from the IP Assignment. 
Note: Access to ICA-100 series is done through assigning a proper IP address. Please 
make sure to use a vacant IP address when you assign the IP address for ICA-100 
series. This will prevent errors from occurring if the IP address is overlapped. 

Manually Assign 

You can click “Manually Assign” and directly enter the IP address. 

The default settings are as follows: 

· Default IP – 192.168.0.20 

· Subnet Mask – 255.255.255.0 

· Default Gateway – 0.0.0.0 

Assign Automatically Using 

If your network is using RARP, BOOTP or DHCP server you can click “Assign 
Automatically Using” and click on “RARP”, “BOOTP” or “DHCP”. Under this 
setting ICA-100 series will automatically assign an IP address from RARP, BOOTP 
or DHCP server. Each time ICA-100 series starts up be sure the RARP, BOOTP or 
DHCP server is setup as assign a static IP to your Internet Camera. If your applica-
tion requires direct connection from an ADSL modem through ICA-100 series’s RJ-
45 LAN port and you also have an ISP PPPoE account. Click on “PPPoE” option 
and enter the Service Name, User ID and Password into the respective fields. ICA-
100 series will get an IP address from the ISP each time ICA-100 series starts up. 

DNS IP Address: 
DNS (Domain Name System) server is an Internet service that translates domain 
names into IP addresses. Enter at least one DNS IP Address. 

Dynamic DNS: 
Click Yes/No to enable/disable DDNS function. Before you use this function, you must 
register a hostname from a DDNS service provider first. 

Service Provider 
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Enter the URL of the DDNS service provider whom you registered to. 

Host Name 
Enter the hostname you registered. 

User Name 
Enter the user name that used to login the DDNS web site. 

Password 
Enter the password of your account. 

Wireless Interface: (ICA-100W only) 

Connection Mode: 
Use the Connection Mode to determine the type of wireless communication for ICA-
100W. There are three choices of Infrastructure mode, 802.11 Adhoc mode and 
Adhoc mode. The default setting for the Connection Mode is Infrastructure. 

Note: Keep in mind after setting the Wireless Interface, making sure that the Slide 
Switch on the rear panel is positioned to either LAN/WLAN or WLAN setting for the 
wireless communication to take effect. 

Network Name: 
This field is used to setup which wireless network (ESS-ID Extended Service Set ID) 
ICA-100W is to be connected for communication. The ESS-ID is a unique identifier 
shared among all points in a wireless network environment. The default Network 
Name is blank space (NULL String), this default setting will let ICA-100W connect 
to ANY access point under the infrastructure network mode. To connect ICA-100W 
to a specific access point on the network make sure to set the ESS-ID of ICA-100W 
to correspond with the access point’s ESS-ID for communication. Type any string 
up to 32 characters long (spaces, symbols, and punctuation are not allowed) in the 
Network Name box. 

To connect ICA-100W to an Ad-hoc wireless workgroup make sure to set the same 
wireless channel and ESSID to match with the PC/Notebook wireless channel and 
ESS-ID for direct wireless communication under the Ad-hoc wireless workgroup 
(ad-hoc and 802.11 ad-hoc modes). 

Note : ICA-100W ad-hoc mode supports two modes (802.11 ad-hoc mode and 
proprietary ad-hoc mode). Which option should be chosen depends on which ad-
hoc mode is supported by your wireless card driver on the PC/ Notebook. Some 
driver supports both modes, however, some driver support only one of the modes. 
The names of each ad-hoc mode may not be consistent between each wireless 
card vendor therefore you may need to try each of the ad-hoc mode (802.11 mode 
and proprietary mode) and select the mode that can communicate with each other. 

Wireless Channel: 
The pull down menu provides the wireless channel for communication. A "channel" 
is a range of frequencies to be used in communication between ICA-100W and Ac-
cess Point in infrastructure mode or ICA-100W and PC/Notebook in Ad-hoc mode. 
Select the appropriate channel from the list provided depending on the regulatory 
region that the unit is sold. The default setting is at channel 11. 

Encryption WEP Key: 
Wireless network communications are easily intercepted. WEP (Wired Equivalent 
Privacy) is an encryption method specified by the IEEE 802.11b standard to make 
any intercepted communications extremely difficult to interpret by unauthorized par-
ties. To enable WEP Encryption, first decide which WEP key format will be applied. 
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Click on ASCII or HEX check box to select input format as ASCII format or HEX 
format, and then input WEP key. To Confirm the WEP key you must enter the data 
once again in the Confirm WEP Key field. 

ASCII input format: 
ASCII format causes each character to be interpreted as an eight-bit value. All 
unaccented upper- and lower-case Western European characters that can be 
input through your keyboard's typing zone are valid. To setup 64-bit WEP key, 
input 5 ASCII characters, for example, ‘12345’. To setup 128-bit WEP key, input 
13 ASCII characters, for example, ‘1234567890123’. These character counts 
result in bit counts of 40 and 104, respectively; ICA-100W will automatically pad 
your input to a bit count of 64 or 128. 

HEX input format: 
Hex format causes each pair of characters you type to be interpreted as an 
eight-bit value in hexadecimal (base 16) notation. Only the digits 0 through 9 and 
the letters A through F (in upper or lower case) are valid. To setup 64-bit WEP 
key, input 10 HEX format, for example, ‘3132333435’, this is the same with 
ASCII input ‘12345’. To setup 128-bit WEP key, input 26 HEX format, for exam-
ple, ‘31323334353637383930313233’, this is the same with ASCII input 
‘1234567890123’. These character counts result in bit counts of 40 and 104, re-
spectively; ICA-100W will automatically pad your input to a bit count of 64 or 128. 

On the Confirm WEP Key field, input the same characters as the Encryption 
Code field. Make sure the Encryption Code is the same with the access point’s 
encryption code that ICA-100W is to be connected under Infrastructure mode. 
Your PC/Notebook’s encryption code also needs to be setup the same with ICA-
100W's encryption code under either Infrastructure mode or Ad-hoc mode. 

The default setting for the Encryption Key is Disable therefore, to secure the 
wireless transmission be sure to Enable the Encryption Key by entering the rele-
vant data. 

Note: Carefully input Encryption Code, any error setting will cause communica-
tion link to fail. 

LED Control: 
The LED control allows user to setup the LED illumination as desired. This feature 
provides the flexibility when surveillance activity is ON. 

There are three options as follows: 

Normal  
Power - Steady On of the LED indicator. 

LAN - Steady On of the LED indicator. When LAN activity is present the LED indica-
tor will flash steadily. 

OFF 
Power - LED indicator is off 

LAN - LED indicator is off 

Dummy  
Power - Steady On of the LED indicator. 

LAN - Steady On of the LED indicator with random flashing.  

The default setting for the LED control is at Normal. When you have configured the 
LED control the correct illumination will set in after 1 minute. 
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Note: This function is built-in to the LED indicators to add extra capabilities. The three 
options allow the Administrator to configure and camouflage the illumination for the 
LED indicator to falsify the monitoring status. In Normal Mode the LED indicator func-
tions as normally. Under Off Mode the LED indicators are both off however, it is still 
monitoring the activity. In Dummy Mode the LED indicators operate in monitoring 
condition but monitoring activity is off or on.  
Loading ActiveX From: 
This field is used to specify the location of Xplug Control (ActiveX) plug-in program. 
Enter the information as required in .ocx format, for example: http://www.<your com-
pany>.com/xplug.ocx where <your company> must be replaced with your company’s 
DNS name. 
Open Second Port: 
The Web Server field allows settings to open a second port for ICA-100 series. This 
will permit users IP Sharing Gateways to support multiple Internet Cameras. By default 
Port 80 is always opened for ICA-100 series Web Server access. Select 

“Yes” and input the second port value. For example: If you have 5 Internet Cameras 
to be installed, each with an IP address from 

192.168.0.101 

192.168.0.102 

192.168.0.103 

192.168.0.104 

192.168.0.105 

You can open the second port for each Internet Camera from port 81 to Port 85 as 
illustrated below: 

Internet Camera 1 – IP 192.168.0.101, second web port 81 

Internet Camera 2 – IP 192.168.0.102, second web port 82 

Internet Camera 3 – IP 192.168.0.103, second web port 83 

Internet Camera 4 – IP 192.168.0.104, second web port 84 

Internet Camera 5 – IP 192.168.0.105, second web port 85 

You also need to setup your DSL gateway for Port Mapping. 

Port 81 map to 192.168.0.101 

Port 82 map to 192.168.0.102 

Port 83 map to 192.168.0.103 

Port 84 map to 192.168.0.104 

Port 85 map to 192.168.0.105 

The Transfer Image field allows settings to open a second port for ICA-100 series to 
transfer images. The default Port 8481 is open image transfer and you can define a 
second port similar to the above. 

Save/Cancel: 

After making sure all settings in the System are correct, click on the “Save” icon to 
store the settings for ICA-100 series. You can alternatively click on the “Cancel” icon 
to restore all settings to the values last saved to or retrieved from ICA-100 series. 
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Image 

Image menu in the system administration contains commands to provide the settings 
for the images captured by ICA-100 series. Click on “Image” in the system administra-
tion menu bar and the Image screen will appear as illustrated below: 

 
Figure 3-3: Image Screen 

Video Resolution: 
Select the desired video resolution format ranging from 320x240 (default) or 640x480. 

Compression Rate: 
Select the desired compression rate with five levels from very low to very high. Higher 
video compression rate will generate more compact file size with less video quality and 
vise-versa. The default setting is at Medium. 

Frame Rate: 
Select the frame rate desired with default setting at Auto for optimal frame rate. 

Brightness Control: 
Adjust the brightness level with default setting at 64. 

Contrast Control: 
Adjust the contrast level with default setting at 64. 

Hue Control: 
Adjust the hue level with default setting at 64. 

Light Frequency: 
Adjust the light frequency to suit your area of operation from the options either 50 Hz 
or 60 Hz (default). 

Note: 50 Hz and 60 Hz variants are available to accommodate the different light 
frequency found in USA (60 Hz) and Europe (50 Hz) for ICA-100 series to ensure 
better image quality. 

Save/Cancel: 
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After making sure all settings in the Image are correct, click on the “Save” icon to 
store the settings for ICA-100 series. You can alternatively click on the “Cancel” icon 
to restore all settings to the values last saved to or retrieved from ICA-100 series. 

Users 

The User options menu contains commands to allow system administrator to assign 
legal users who are permitted to monitor ICA-100 series from the remote site. 
Click on “Users” in the system administration menu bar and the Users screen will 
appear as illustrated below: 
 

 
Figure 3-4: Users Screen 

Add User: 

User Name: 
Enter the user name in this field. A maximum of 64 users names are allowed, how-
ever each users name must be different. Each user name can be used as a group 
given the password for example, if the User Name is “Guest” and the User Pass-
word is “Guest” anyone can access ICA-100 series with these details used as a 
group of users under the User Name Guest. The maximum length for the User 
Name is 12 (Printable ASCII). 

User Password: 
Enter the user’s password assigned by the administrator. The maximum password 
length is 8 (Printable ASCII). 

I/O Output Control: 
Administrator has the authority to give permission for the privilege to control the I/O 
Output Control to user’s by selecting “Yes” or “No” to activate the I/O Output con-
trol. 

To add a new users name input the necessary information first and click on the “Add” 
icon. 

Delete User: 

Select the user you wish to delete from the pull down menu and click on the “delete” 
icon. 

Note: Once administrator has configured ICA-100 series Users, any user will be 
required to enter a login password to access the video image of ICA-100 series. 
The password dialog box is illustrated below. 
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Figure 3-5: User Login Screen 

DateTime 

The DateTime menu contains commands for setting ICA-100 series' time and date 
requirements to provide correct information to users who might be thousands of miles 
away in the remote site. There are two options to select from the DateTime menu bar 
either Synchronized with Time Server or Set Manually. Click on “DateTime” in the 
system administration menu bar and the DateTime screen will appear as illustrated 
below: 

 
Figure 3-6: DateTime Screen 

DateTime: 

Select “Synchronized with Time Server” and the time will be based on GMT setting. 
The time will be synchronized every 10 minutes. This is also the default setting for ICA-
100 series. 

IP Address: 
Enter the IP Address of the Time Server in this field. 
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Note: Please find below NTP server web address for your reference to set the time 
server. 
http://www.eecis.udel.edu/~mills/ntp/clock1.htm 
http://www.eecis.udel.edu/~mills/ntp/clock2.htm 
 

Protocol: 
Two options of NTP or Time are available for your selection to link with the Time 
Server. The default setting is NTP. 

TimeZone: 
System administrator must select the time zone for the region. Please refer to the 
appendix for the time zone selection table.  

To set the Date Time manually select “Set Manually” and system administrator must 
enter the Date and Time in the respective field manually. 

Note: When you select Set Manually, each time ICA-100 series is powered off and 
on you must re-enter the details once again due to time lost. 

Save/Cancel: 

After making sure all settings in the DateTime are correct, click on the “Save” icon to 
store the settings for ICA-100 series. You can alternatively click on the “Cancel” icon 
to restore all settings to the values last saved to or retrieved from ICA-100 series. 

Trigger 

The Trigger menu contains commands for the I/O Trigger connectors providing the 
physical interface for 2 digital output and 2 digital input that is used for connecting a 
diversity of external alarm devices to ICA-100 series such as IR-Sensor and alarm 
relay. Click on “Trigger” in the system administration menu bar and the Trigger 
screen will appear as illustrated below: 
 

http://www.eecis.udel.edu/~mills/ntp/clock1.htm
http://www.eecis.udel.edu/~mills/ntp/clock2.htm
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Figure 3-7: Trigger Screen 

The default setting for the I/O Trigger functions are disabled.  You must enable the I/O 
Trigger first before the Triggers will perform. There are two options to select from the 
Trigger screen I/O Input 1 Trigger and I/O Input 2 Trigger. 

I/O Input 1 Trigger: 

Select “Send e-mail attached with image” and enter the relevant information such 
as the SMTP Server Address, Sender e-mail Address, Receiver e-mail Address, 
Sending Interval and Sending Times. 

SMTP Server Address  
SMTP(Simple Mail Transfer Protocol) is a protocol for sending e-mail messages 
between servers. The mail server address must be filled in this field. If the SMTP 
server needs authentication, ICA-100 series will use Admin ID and Admin Pass-
word entered in System page as login account and password. 

Sender e-mail Address  
The e-mail address of who will be sending the e-mail. 

Receiver e-mail  
The e-mail address of the person whom will receive the e-mail. 

Sending Interval  
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The period of time between each email being sent to the receiver. If the setting is at 
10 seconds, a new e-mail will be sent in 10 seconds interval to the receiver. 

Sending Time  
The number of times the e-mail will be sent to the receiver before it terminates. 

Select “Trigger I/O Output” and enter the setting for Output 1 time and Output 2 time 
in seconds. These fields determine the duration for activating the external output 
devices. 

I/O Input 2 Trigger setting procedures are same as above. 

 

Save/Cancel: 

After making sure all settings in the System are correct, click on the “Save” icon to 
store the settings for ICA-100 series. You can alternatively click on the “Cancel” icon 
to restore all settings to the values last saved to or retrieved from ICA-100 series. 

Please refer to the appendix for detailed information regarding the I/O Connector. 

Warning 
When connecting other devices through the I/O connectors, please make sure the 
maximum current of 100mA is strictly observed. Any failure to do so might cause a 
loss of power to ICA-100 series and possibly cause serious damage to ICA-100 series. 

 

Upload 

The Upload menu contains commands for setting ICA-100 series to upload images to 
a specified FTP server, time scheduling, and manual operation. Click on “Upload” in 
the system administration menu bar and the Upload screen will appear as illustrated 
below: 

Note: Before using the Upload function, please ensure the User account used has 
“write” permission of the FTP server or the specified folder. 
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Figure 3-8: Upload Screen 

FTP Server: 

Host Address: 
Enter the IP address of target FTP server. 

Port Number: 
Most of the FTP servers using port 21. If the target FTP server uses specific port, 
please ask the FTP server administrator to provide the information. 

User Name: 
Enter the user name used to login FTP server in this field. 

Password: 
Enter the password used to login FTP server in this field. 

Directory Path: 
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Enter a folder name which already exists in FTP server, then the images will be up-
loaded to the given folder. 

Passive Mode: 
Some FTP servers use passive mode. Please confirm this with the FTP server ad-
ministrator. 

Time Schedule: 

Enable “Upload image to FTP server” and enter the appropriate information such as 
the schedule, image frequency and base file name. 

Schedule: 

Select Always option, ICA-100 series will try to connect the FTP server and start 
uploading right after the configuration saved. 

Select Schedule option to manage the uploading task. Input the desired Day and 
Time Period parameters in corresponding fields. 

Image Frequency: 
Here provides two ways to set the image frequency: 

Set Auto/1/2/3 frames per second, or 

Set the interval of two sequential frames in seconds. 

Base File Name: 
Enter the file name for the uploaded image. 

File: 

Choose Overwrite option, then every time you upload the image to FTP server, it 
will use the same file name and overwrite the previous one. There will be only one 
image stored in FTP server. 

Choose Date/Time Suffix option, and the full file name of the image will be “Base 
File Name+ Date+ Time”. 

Choose Sequence Number Suffix Up to option, and the full file name of the image 
will be “Base File Name+ Sequence Number”. For example, if you enter “3” in this 
option, Internet Camera will create three files named BaseName1, BaseName2, 
BaseName3 in FTP server. The fourth file will use file name of BaseName1 and the 
previous file with the same name will be overwritten. 

Manual Operation: 

Enable this option, then every time you click the Image Upload “ON” button on View 
Image- ActiveX Mode or View Image- Java Mode web pages, Internet Camera will 
start to upload the image. The setting of the uploaded file name please refer to Base 
File Name and File above. 

Save/Cancel: 

After all the changes are done, click on the Save button to store the settings, and it will 
take effect immediately. Or click Cancel to discard all the changes. 

 

Information 

The Information menu contains commands for displaying information about ICA-100 
series. Click on “Information” in the system administration menu bar and the Informa-
tion screen will appear as illustrated below: 
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Figure 3-9: Information Screen 

The Information table provides detailed information of ICA-100 series such as the 
Model Name, Firmware Version, Mac Address, and IP Address. 

Tools 

The Tools menu contains commands for restarting ICA-100 series. Click on “Tools” 
in the system administration menu bar and the Tools screen will appear as 
illustrated below: 

 
Figure 3-10: Tools Screen 

Reset: 
The Reset command restarts ICA-100 series just like turning the device off and on and 
saved settings are retained. The Reset panel contains the message “Do you really 
want to reset this device?” and a YES button. If you do not want to reset ICA-100 
series, exit the panel without clicking YES, otherwise, click on the “YES” icon and the 
reset process will initiate. 

Factory Reset: 
A factory reset restarts ICA-100 series and returns all of its settings to their default 
values. The Factory Reset panel contains the message “Do you really want to factory 
reset this device?” and a YES button. If you do not want to carry out a factory reset 
command, exit the panel without clicking YES, otherwise click on the “YES” icon and 
factory reset will be initiated.  

Note: The Network must be reconfigured after a Factory Reset. Once the configu-
ration is completed click on “Home” to return to the Welcome screen and select 
the desired Viewing Image either through ActiveX Mode or Java Mode as described 
in the next section. Then position ICA-100 series to the desired location appropri-
ately for your purpose. Followed by adjustment of ICA-100 series focus, done 
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manually by turning the lens clockwise or anti-clockwise to the desire image quality. 
Please refer to the appendix for detailed information regarding Adjust Internet 
Camera Focus and Replacing the Lens. 

 
View Image- ActiveX Mode 
Before using ActiveX mode to view image, the Xplug Control (ActiveX) plug-in program 
must install into the PC/Notebook first. Please refer to the appendix for detailed infor-
mation regarding Installation of Xplug Control (ActiveX) into your PC/Notebook or Web 
Server. 
To view video images from the browser, click on “View Image – ActiveX Mode” from 
the Home page to access the video images from Internet Explorer as illustrated below: 
 

 
Figure 3-11: View Image- ActiveX Mode 

Camera Name   
The Camera name will be display when the Camera Name field is entered in the Web 
Configuration setting under “System” 

Location 

The location of ICA-100 series will be displayed when the Location field is entered in 
the Web Configuration settings under “System”. 

Date/ Time 

It indicates current date and time. 

Note: Please refer to the appendix on how to install ActiveX. 

1. Install to the Web Server 

2. Install to your Local PC 

In the View Image – ActiveX Mode you are allowed two output trigger options. Click on 
the “ON” button can activate the external device immediately. Click on the “OFF” 
button can deactivate it. 

The explanation of Image Upload button please refers to Upload web page of System 

Camera Name 
Location 
Date/Time 
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Administration. 

View Image- Java Mode 
Click on “View Image – Java Mode” from the Welcome screen to access the video 
images from the Internet Explorer or Netscape browser as illustrated below: 
 

 
Figure 3-12: View Image- Java Mode 

Camera Name  
The Camera name will be display when the Camera Name field is entered in the Web 
Configuration setting under “System” 

Location 

The location of ICA-100 series will be displayed when the Location field is entered in 
the Web Configuration settings under “System”. 

Date/ Time 

It indicates current date and time. 

Note: Please refer to the appendix on how to install ActiveX. 

1. Install to the Web Server 

2. Install to your Local PC 

In the View Image – Java Mode you are allowed two output trigger options. Click on 
the “ON” button can activate the external device immediately. Click on the “OFF” 
button can deactivate it. 

The explanation of Image Upload button please refers to Upload web page of System 
Administration. 

Camera Name 
Location 
Date/Time 
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Chapter 4 
IPView Installation 

This Chapter details the installation procedure of IPView utility. 

Install Procedure 
STEP 1 
Insert the CD-ROM into the CD-ROM drive to initiate the autorun program. Once 
completed a menu screen will appear as follows: 

 
Figure 4-1: Menu Screen 

STEP 2 
To install the IPView Application click on the "IPView" hyperlink to activate the installa-
tion procedure for the application program. 
If the above screen is not shown, you can start the installation as follows. 

1. Click on Start Menu/ Run. 
2. Enter “D:\IPView\ipviewsetup.exe” in the appeared box, where “D” is the letter of 

your CD-ROM drive. 
3. Click on “OK” button. 

 
STEP 3 
The Welcome screen will appear. Click on the “Next” button to proceed with the 
installation. 

4 
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Figure 4-2: Welcome Screen 

STEP 4 
The License Agreement prompt will appear as below. Read the details carefully and 
click on the “Yes” icon to continue with the installation procedure. 
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Figure 4-3: License Agreement 

STEP 5 
A prompt will appear and in the Destination Location dialog box, you may click on 
“Next” to accept the recommended destination location or click on “Browse” to select 
another location. After specifying the desired destination location, click on “Next” to 
proceed further. 

 
Figure 4-4: Destination Location 

STEP 6 
The Select Program Folder prompt will appear providing information of where the 
IPView application will be located, click on “Next” to continue. Click on “Back” can 
return to the previous screens. 
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Figure 4-5: Select Program Folder 

STEP 7 
Please wait until Figure  4-7 or Figure 4-8 appears. Select “Yes, I want to restart my 
computer now” and click on the “Finish” icon to restart the computer in Figure 4-7. If 
Figure 4-8 appears, click on the “Finish” icon to complete the installation procedure. 

 
Figure 4-6: Finish Screen 
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Figure 4-7: Finish Screen 

Launch IPView 
After successfully installing the IPView, the application program is automatically in-
stalled to \Program Files\IPView. 
Click on Start Menu/Programs/IPView/IPView to launch the program. 
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Figure 4-8: IPView Path 

Once IPView is executed, a Login dialog box will appear, you must enter the default 
User Name: admin into the respective field and click on “OK” to log into the applica-
tion. 

 
Figure 4-9: IPView Login Dialog Box 
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After login, the IPView application is executed and its interface will appear as follows in 
the default List View format: 
 

 
Figure 4-10: List View Format 
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Chapter 5 
Use of IPView 

This chapter describes operation of the IPView application interface 
with detailed procedures for using the application. 

 

Overview 
IPView is responsible for the management of preview, configuration, and searching of 
each camera. It is designed with a user-friendly interface for ease of control and 
navigation requirements as illustrated below. 
 

Security 
When IPView is used for the first time it is highly recommended to change the User 
Name and Password by the Administrator to constrain users access to the IPView 
application. This procedure should be done as soon as possible to prevent unauthor-
ized usage of IPView application. 

To change the User Name and Password, select “Tools” > “Options”. The Options 
dialog box will appear as illustrated below. 

 
Figure 5-1: Option Screen 

 
The administrator needs to enter a User Name, Password and Confirm password 
into the respective fields. Once all the new details are entered click on the “OK” icon. 
Make sure to save any changes you have made to keep the information updated. 

5 
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Note: Alternatively you can click the Options icon  as illustrated or use the hot key 
“F10”. 

 

Menu Bar 
The menu bar provides easier access for users to navigate the IPView with different 
selections along with hot key capabilities as follows: 

File 

“File” on the menu bar provides “New”, “Open”, “Save”, “Save As” and “Exit” for 
users to create new files, open existing files, save files, and exit the IPView as de-
picted below. 
 

 
Figure 5-2: File Screen 

 
View 

“View” on the menu bar provide users with management capabilities for “Columns”, 
“List”, “Camera” and “Refresh”. You can view Camera in “1 Camera”, “4 Cam-
eras”, “9 Cameras”, “16 Cameras”. The “View” menu bar is pictured below. 
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Figure 5-3: View Screen 
 

Camera 

“Camera” on the menu bar provides options to manage the camera. One can “Add” 
additional Camera with a maximum of 16 Camera allowed for viewing. Through the 
management function one can “Delete” a camera, manage the “Property”, “Enable” 
for real time and take a “Snap shot” image. The menu bar is illustrated below: 
 

 
Figure 5-4: Camera Screen 

 
By default the video image is enabled. There will be a “check” next to the Enable 
command to show that the Enable function is working. To disable real-time image 
select “Camera” > “Enable” and real-time video image will stop and shutdown. 
Once you select “Motion Active Mode” of a specific camera, the “Enable Motion” 
option will add to the drop-down list as below. 
 

 
Figure 5-5: Camera Screen in Motion Active Mode 

 
Tools 

"Tools" on the menu bar allows administrator management of the security settings 
such as User Name and Password to gain access into the IPView application. From 
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the menu bar select "Tools” > "Options" and a dialog box will appear. Administrator 
can change the User Name and Password for security settings to access the applica-
tion. 
 

 
Figure 5-5: Tools Screen 

 
Help 

“Help” on the menu bar provides “Contents” and “About” to assist users how to 
operate the camera in HTLM format. From the menu bar select “Help” and can 
choose either “Contents” or “About” as depicted below: 
 

 
Figure 5-6: Help Screen 

 

Add Camera 

Select “Camera” > “Add” on status bar or choose  from toolbar or use the hot-
key “Shift + Ins”. An Add Camera dialog box will appear as illustrated below. 
 

 
Figure 5-7: Add Camera Screen 

 
You can enter the IP Address of the camera in the specified field and click the “Add” 
icon to add a new camera. If the IP Address is entered incorrectly a dialog box will 
appear to notify the error. If ICA-100 series are installed on Internet and have real IP 
addresses, they can only be added by entering correct IP address. 
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Figure 5-8: Warning Message 

 
If you are unsure of the IP Address of the camera you can click on the “Browse” icon, 
the Browse Camera dialog box will appear with a blank screen as illustrated below. 
 

 
Figure 5-9: Browse Camera Screen 

 
Click on the “Search” icon and IPView will detect and search all the available cam-
era’s that are installed on the local area network as depicted below: 
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Figure 5-10: Search for Camera 

 
Select the camera want to add and click on the “Add” icon. The Add Camera dialog 
box will appear again with the IP Address entered. Click on the “Add” icon and the 
camera will be automatically added into IPView list view format. Alternatively you can 
double click on the camera and the Add Camera dialog box will appear again with the 
IP Address entered. Click on the “Add” icon and the camera will be automatically 
added into IPView list view format. 
 

 
Figure 5-11: Enter Camera IP 

If administrator has set the User Name and Password to ICA-100 series during con-
figuration, a dialog box below will appear. 

 

 
Figure 5-12: Login Camera 
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Enter the correct User Name and Password to add camera in the list. Please note that 
only one camera can be added at a time. 

 

Delete Camera 
Select the camera wants to delete from IPView list view format. From the menu bar 

select “Camera” > “Delete” or click  from toolbar or use hot-key “Del”. A Delete 
Camera dialog box will appear and click on the “Yes” icon to delete the camera or 
click on “No” if you do not want to delete the camera. 
 

View Images 
From the menu bar select “View” > “4 Cameras” (other choices are available with 1 
Camera, 9 Cameras and 16 Cameras viewing format) and the viewing screen will 
appear with the video image. Alternatively you can click the 1 Camera icon as illus-

trated  or use the hot key “Ctrl+F3”. For 4 Cameras , 9 Cameras and 16 
Cameras click the respective icon or use the hot key as follows “Ctrl+F4”, 
“Ctrl+F5” and “Ctrl+F6”. To return to list view format use the hot key “Ctrl+F1”. 
 

 
Figure 5-13: 4 Cameras View 

 
The icon on the upper left corner of each partition indicates the sequence number of 
each camera on the IPView list. 

To return to the IPView list view format, right click on the icon located on the upper left 
corner of the screen and a menu will appear. Select “List” and the viewing image will 
return to the list view format. 
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Snap Shot 
To snap shot a single image, highlight the camera you wish to snap shot from the list 

view format. Select “Camera” > “Snap shot” from menu bar or click  from toolbar 
or use the hot-key “F5”. A Save Image dialog box will appear for specifying the path of 
snap shot picture. Or from the viewing mode either 1, 4, 9, 16 cameras right click on 
the icon located on the upper left corner of the screen and a menu will appear and 
select the “Snap shot” icon. A Save Image dialog box will appear for specifying the 
path of snap shot picture.  
 

Record Images 

Choose a camera first, from the menu bar select “Camera” > “Start” or click  
from toolbar or use the hot-key “F7”. The recorded file will be saved as AVI format. 
Video recording can also be activated from the viewing mode either 1, 4, 9, 16 cam-
eras right click on the icon located on the upper left corner of the screen and a menu 
will appear. Select the “Start” icon. If you want to specify the path of the recording file 
saved, please refer to Property section. 

To stop recording a camera, you must select the camera from list view format first. 
From the menu bar select “Camera” > “Stop” or click  from toolbar or use the hot-
key “F9”. The recording function will be stopped. The alternative way is from the view-
ing mode either 1, 4, 9, 16 cameras right click on the icon located on the upper left 
corner of the screen and a menu will appear. Select the “Stop” icon. The recording 
function will be stopped. 

 

Property 
“Property” option can use to configure the settings of ICA-100 series. Select a cam-
era from list view format, then select “Camera” > “Property” from menu bar or click 

 from toolbar or use the hot-key “F2”. Then Camera Property dialog box will appear 
allowing to configure the chosen camera.  
Note: Make sure to click the “Apply” button to save changes you have made to keep 
the information updated. 
 
General 

It allows settings for the camera name, location and administrator information such as 
administrator ID and password. Please refer to Chapter 3 Configuration à System 
Administration à System section for further details. 
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Figure 5-14: General Screen 

 
IP Assignment 

There are two options to select from the IP Assignment either Manually Assign or 
Assign Automatically Using. Please refer to Chapter 3 Configuration à System 
Administration à System section for further details. 
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Figure 5-15: IP Assignment Screen 

 
DNS 

DNS (Domain Name System) server is an Internet service that translates domain 
names into IP addresses. Enter at least one DNS IP Address. Please refer to Chapter 
3 Configuration à System Administration à System section for further details. 
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Figure 5-16: DNS Screen 

 
Wireless 

(Please skip this section if your camera is not wireless.) 
Allows setting for connection mode, network name, wireless channel, and WEP key. 
Please refer to Chapter 3 Configuration à System Administration à System section 
for further details. 
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Figure 5-17: Wireless Screen 

 
Misc 

Allows setting for LED Control, ActiveX control location, and second port. Please refer 
to Chapter 3 Configuration à System Administration à System section for further 
details. 
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Figure 5-18: Misc Screen 

 
Image 

Image provides the settings for the video image of the camera such as brightness, 
contrast, saturation, resolution, compression, frame rate, and light frequency. Please 
refer to Chapter 3 Configuration à System Administration à Image section for further 
details. 
Regarding the Date Display field, there are three available options: No Display, 
Opaque Mode, and Transparent Mode. Choosing “Opaque Mode”, the background of 
the time stamp will be filled with white color. Choosing “Transparent Mode”, the time 
stamp will display on the screen with no background color.  
Please note that this function is controlled by IPView software, so the time stamp can 
be displayed on live image with IPView and the recorded files. But if you use web 
browser to view the live image or upload single pictures to a FTP server, there would 
be no time stamp appeared. 
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Figure 5-19: Image Screen 

 
User 

This option allows system administrator to assign legal users who are permitted to 
monitor the camera from the remote site by Add or Delete user. 
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Figure 5-20: User Screen 

 
To add a user click on the “Add” icon and the Add User dialog box will appear. Enter 
the User Name and Password into the specific field. Select the I/O Output Control to 
give users the privilege of accessing the I/O Output Control. 
 

 
Figure 5-21: Add User Screen 

 
To delete a user, select the user and click on the “Delete” icon. Please refer to Chap-
ter 3 Configuration à System Administration à Users section for further details. 
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Date/Time 

Provides two settings of  adjusting the camera’s time and date: Synchronized with 
Time Server or Set Manually. Please refer to Chapter 3 Configuration à System 
Administration à DateTime section for further details. 
 

 
Figure 5-22: Date/Time Screen 

 
Trigger 1 

Provides the settings of first set I/O trigger connectors. Please refer to Chapter 3 
Configuration à System Administration à Trigger section for further details. 
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Figure 5-23: Trigger1 Screen 

 
Trigger 2 

Provides the settings of first set I/O trigger connectors. Please refer to Chapter 3 
Configuration à System Administration à Trigger section for further details. 
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Figure 5-24: Trigger2 Screen 

 
Information 

Displays information about the camera such as the model, firmware version, MAC 
address, and IP address. Please refer to Chapter 3 Configuration à System Admini-
stration à Information section for further details. 
 



Advanced Configuration 

51 

 
Figure 5-25: Information Screen 

 
Tools 

Proving functions for reset the camera and update firmware. Please refer to Chapter 3 
Configuration à System Administration à Tools section for further details on reset. 
Firmware Upgrade Procedure: 
1. Download the latest firmware to a PC .  
2. Activate IPView, select “Camera” > “Properties” and the Camera Property 

dialog box will appear.  
3. Select the Tools tab and enter the full path of the firmware binary file name in the 

Update Firmware field or you can click on the “Browse” icon to select the file. 
Once the firmware file is entered, click on the “Update” icon to proceed with the 
updating process.  

4. After process completed, click on the “OK” button below. 
  

Warning 
During firmware update process please make sure no interruptions will occur as it 
might possibly cause serious damage to the Internet Camera 
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Figure 5-26: Tools Screen 
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Recording 

 
Figure 5-27: Recording Screen 

 

Recording File Path: 
There are four file paths can be set here and only one of them is working at one time. 
It is suggested to set them to different disk drives. For example: set path 1 to C drive, 
and set path 2 to D drive. Once C drive run out of its disk space, IPView will switch the 
file path to path 2 automatically so that the recording task won’t be interrupted.  

Recording File Options: 
You can set the upper limitation of each file by the file size or recording time. Once the 
file reaches the limitation allocated, IPView will create a new file and keep recording. 
Furthermore, you can select the compression rate of the file by clicking the drop-down 
list behind “Compression”. 

Recording Options: 
This field is for Manual and Schedule recording mode. Select “FullTime”, IPView will 
record every image frames. Select “Dynamic”, IPView will record the images which 
different from previous one. Therefore, when you play this type of files, the video will 
be choppy. But Dynamic mode allows user to save hard disk space. 

Recording Action Mode: 
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Manual 
Manually control the recording operation. 

Schedule Mode 
Select this option and click “Advanced Setting” for detailed configurations. The pre-
defined schedule can be set by date or weekday. 

 

Figure 5-28: Schedule Setting Screen 
Motion Active Mode 
Select this option and click “Advanced Setting” for detailed configurations. You can 
adjust the sensitivity level and choose the warning options when IPView detects a 
motion. 
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Figure 5-29: Motion Setting Screen 
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IPView Icon Description 

 Create a new file. The alternative hot key is Ctrl+N. 

 Open an existing file. The alternative hot key is Ctrl+O. 

 Save a file. The alternative hot key is Ctrl+S. 

 List view format. The alternative hot key is Ctrl+F1. 

 1 camera view format. The alternative hot key is Ctrl+F3. 

 4 cameras view format. The alternative hot key is Ctrl+F4. 

 9 cameras view format. The alternative hot key is Ctrl+F5. 

 16 cameras view format. The alternative hot key is Ctrl+F6. 

 Refresh IPView application. The alternative hot key is F12. 

 Add a camera. The alternative hot key is Shift+Ins. 

 Delete a camera. The alternative hot key is Del. 

 Property settings used for configuring camera. The alternative hot key is F2. 

 Snap shot to capture a single image. The alternative hot key is F5. 

 Start video recording. The alternative hot key is F7. 

 Stop video recording. The alternative hot key is F9. 

 Options to modify the User Name and Password for IPView. The alternative hot 

key is F10. 
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Context Sensitive Meun 
Select a camera in list view format and right click the mouse, a context sensitive menu 

includes features of “Add”, “Delete”, “Property”, “Enable”, “Snap Shot”, and 

recording control options will appears. 

 

Figure 5-30: Context Sensitive Menu in List View Format 
In camera view format, click on the icon located at the upper left corner of the screen 

and a case sensitive menu will appear as illustrated below. The menu includes fea-

tures of “Enable”, image rotate option, “Snap Shot”, “Enable Motion”, trigger 

control options, recording control options, “List”, “1 Camera”, “4 Cameras”, “9 

Cameras”, “16 Cameras”, “Previous Page” and “Next Page”. 
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Figure 5-31: Case Sensitive Menu in Camera View Format 
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Appendix A 
Frequently Asked Questions 

 

 

Internet Camera Features 

Q: What is an Internet Camera? 

A: The Internet Camera is a standalone system connecting directly to an Ethernet 
or Fast Ethernet network. And ICA-100W also supports the wireless transmission 
based on the IEEE 802.11b standard. It is different from the conventional PC Cam-
era, the Internet Camera is an all-in-one system with built-in CPU and web-based 
solutions providing a low cost solution that can transmit high quality video images 
for monitoring. The Internet Camera can be managed remotely, accessed and 
controlled from any PC/Notebook over the Intranet or Internet via a web browser. 

Q: What is the maximum number of users that can be allowed to access the Inter-
net Camera simultaneously? 

A: Maximum number of users that can log onto the Internet Camera at the same 
time is 64. Please keep in mind the overall performance of the transmission speed 
will slow down when many users are logged on. 

Q: What algorithm is used to compress the digital image? 

A: The Internet Camera utilizes the JPEG image compression technology providing 
high quality images for users. JPEG is adopted since it is a standard for image 
compression and can be applied to various web browser and application software 
without the need to install extra software. 

Q: Can I change the wireless antenna attached to the Wireless Internet Camera? 

A: The wireless antenna can be changed for a variety of reasons such as extending 
the wireless transmission range, however, please consult authorized distributors 
before attempting as the connectors must be SMA connector type. 

Q: What is the wireless transmission range for the Wireless Internet Camera? 

A: Generally the wireless distance can go up to 100 meters indoors and up to 300 
meters outdoors. The range are limited by the number of walls, ceilings, or other 
objects that the wireless signals must pass through. Typical ranges vary depends 
on the types of materials and background Radio Frequency (RF) noise in your home 
or business and the configuration setting of your network environment. 

Internet Camera Installation 

Q: Can the Internet Camera be used out-doors? 

A: The Internet Camera is not weatherproof. It needs to be equipped with a weath-
erproof case to be used outdoors and it is not recommended. 

Q: What network cabling is required for the Internet Camera? 

A: The Internet Camera uses Category 5 UTP cable allowing 10 Base-T and 100 
Base-T networking. 

A 
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Q: Can the Internet Camera be setup as a PC-cam on the computer? 

A: No, the Internet Camera can be used only on Ethernet and Fast Ethernet net-
work. 

Q: Can the Internet Camera be connected on the network if it consists of only private 
IP addresses? 

A: The Internet Camera can be connected to LAN with private IP addresses. 

Q: Can the Internet Camera be installed and work if a firewall exists on the network? 

A: If a firewall exists on the network, port 80 is open for ordinary data communica-
tion. However, since the Internet Camera transmits image data, the default port 
8481 is also required. Therefore, it is necessary to open port 8481 of the network for 
remote users to access the Internet Camera. 
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Appendix B 

Trouble Shooting 
 

Q: I cannot access the Internet Camera from a web browser? 

A: If ICA-100 series do not respond, check the following: 
• Machine is properly installed, LAN or WLAN connection is OK, and it is pow-

ered ON. You can test the connection by using the "Ping" command: 
Open the MS-DOS window or command prompt window. 
Enter the command: 
   ping 192.168.0.20 
If no response is received, either the connection is not working, or your PC's 
IP address is not compatible with ICA-100 series’ IP Addresses. (See next 
item.) 

• Ensure that your PC is using an IP Address within the range 192.168.0.1 to 
192.168.0.254 (excluding 192.168.0.20).  
Also, the Network Mask should be set to 255.255.255.0 to match ICA-100 se-
ries. In Windows, you can check these settings by using Control Panel-
Network to check the Properties for the TCP/IP protocol. 

Q: Why does the Power LED not light up constantly? 

A: The power supply used might be at fault. Confirm that you are using the pro-
vided power supply DC 5V for the Internet Camera and verify that the power 
supply is well connected. 

Q: Why does the LAN LED not light up properly? 

A1: There might be a problem with the network cable. To confirm that the cables 
are working, PING the address of a known device on the network. If the cabling is 
OK and your network is reachable, you should receive a reply similar to the follow-
ing ( …bytes = 32 time = 2 ms). 

A2: The network device utilized by the Internet Camera is not functioning properly 
such as hubs or switches. Confirm the power for the devices are well connected 
and functioning. 

Q: Why does the Internet Camera work locally but not externally? 

A1: Might be caused from the firewall protection. Need to check the Internet fire-
wall with your system administrator. 

A2: The default router setting might be a possible reason. Need to double check if 
the configuration of the default router settings is required. 

Q: Why do a series of broad vertical white lines appear through out the image? 

A: A likely issue is that the CMOS sensor becomes overloaded when the light 
source is too bright such as direct exposure to sunlight or halogen light. You need 
to reposition the Internet Camera into a more shaded area immediately for the 
bright light will damage the CMOS sensor. 

 

B 
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Q: There is bad focus on the Internet Camera, what should be done? 

A1: The focus might not be correctly adjusted for the line of sight. You need to 
adjust the Internet Camera focus manually as described in Appendix E: Adjust 
Internet Camera Focus. 

A2: The adaptor used is not fitted with your C-type lens. If you have previously 
changed the supplied CS-type lens, you may have unintentionally installed a C-type 
lens without fitting the adaptor first. 

Q: Noisy images occur. How can I solve the problem? 

A1: The video images might be noisy if the Internet Camera is used in a very low 
light environment. To solve this issue you need more light. 

Q: There is a poor image quality, how can I improve the image? 

A1: A possible cause might be the incorrect display properties configuration for your 
desktop. You need to open the Display Properties on your desktop and configure 
your display to show at least 65’000 colors, for example at least 16-bit. 

Note: Applying only 16 or 256 colors on your computer will produce dithering arti-
facts in the image. 

A2: The configuration on the Internet Camera image display is incorrect. You need 
to adjust the image related parameter for improve images such as brightness, con-
trast, hue and light frequency. Please refer to the Image section of Chapter 3 for 
detail information. 

Q: There are no images available through the web browser? 

A: The ActiveX might be disabled. If you are viewing the images from Internet Ex-
plorer make sure ActiveX has been enabled in the Internet Options menu. 
Alternatively, you can use the Java Applet for viewing the required images. 
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Appendix C 
I/O Connectors 
 
An 8-pole connector is provided for auxiliary I/O connections to ICA-100 series. The 
I/O connector provides the physical interface for 2 digital outputs and 2 digital inputs 
that is used for connecting a diversity of external alarm devices to ICA-100 series such 
as IR-Sensor and alarm relay. The digital input is used for connecting external alarm 
devices. Once triggered, images will be taken and e-mailed. The supported transistor 
output can give a maximum of DC 5V to the externally connected alarm devices. Once 
triggered, the current will activate the devices. 

 

In 1 

In 2 

In 1 & In 2 is a pair for digital input. It works at voltage 5V 
 

In 3 

In 4 

In 3 & In 4 is a pair for digital input. It works at voltage 5V 
 

Out 5 - 

Out 6 + 

Out 5 - & Out 6 + is a pair for digital out. The out put voltage is 5 V and 
maximum current is 100 mA 

Out 7 – 

Out 8 + 

Out 7 - & Out 8 + is a pair for digital out. The out put voltage is 5 V and 
maximum current is 100 mA 

 

C 
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Warning 
1. When connecting a device to the Input connector, the device must be a 

passive component without voltage and electrical current. 
2. When connecting other devices through the Output connector, please make 

sure the maximum current of DC 5V, 100mA is strictly observed. 
3. Any failure of the above two points might cause serious damage to the cam-

era. 
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Appendix D 
Adjust Focus/ Replace Lens 
The Internet Camera features an exchangeable CS-type lens that can be used for 
different applications as necessary. It supports rotational focus control so the lens can 
be adjusted to focus under normal and stable conditions to maximize the image quality 
of the Internet Camera. 
 
Adjust Internet Camera Focus 
To adjust the focus of the lens you need to turn the lens slowly in either clockwise or 
counterclockwise direction until the desired image appears. DO NOT over turn the lens 
in either of the directions as it will be out of focus. DO NOT unscrew more than 1.0mm 
apart from the Fixed Lens Assembly unless you want to substitute the lens. While 
adjusting the Internet Camera's focus you can review the image quality from the Web 
browser. 
 
 
 
 

 
 

 
Note: You can also adjust the Internet Camera's image quality through the Web Con-
figuration under System Administration -Image. Please refer to Configuration 
chapter for further details. 
 
 
 
 

 

 

 

 

 

D 

Fixed Lens Assembly 
Do not adjust 

Camera Lens  
Adjust it by clockwise or counterclock-
wise 

Warning 
Direct exposure to sunlight may cause permanent damage to the CMOS sensor. 
Therefore do not expose the Internet Camera’s lens directly to sunlight. When 
operation is required in glaring light environment, it is recommended to use an iris 
lens. 
The Internet Camera is designed for indoor usage and if your application requires 
prolong exposure to sunlight, a sun visor is recommended to protect the Internet 
Camera. 
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Replace the Lens 
Since the Internet Camera is designed with a CS- mount, the lens equipped with the 
Internet Camera can be replaced with any standard C or CS lens commonly used 
within the surveillance industry. 
Follow the instructions below to replace the supplied lens with any C or CS type lens. 
1. Unscrew the Internet Camera lens 
2. C-lens only, attach the new lens to a CS-C adapter 
3. Screw the new lens onto the Internet Camera. If appropriate, adjust the iris accord-

ing to the prevailing light conditions. 
4. Refer to Adjusting the Internet Camera Focus on the previous page. 
5. Refresh the web browser and monitor the results from the Internet Camera. 
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Appendix E 
Install Xplug Control Utility 
 

Install on Web Server 
STEP 1 
Copy xplug.ocx to the home directory of a web server. 

STEP 2 
Log on the Home page of ICA-100 series, click on the “System Administration” link. 
The system page will appear. 

STEP 3 
Locate the “Loading ActiveX From” field on system page. Fill the field with web server’s 
address. Either IP address or Internet address will do. 

 
Once the settings are completed, users are able to access ICA-100 series from the 
web browser by selecting the Image View – ActiveX mode. 
 

Install to Local PC 
STEP 1 
Insert the CD-ROM into the CD-ROM drive to initiate the autorun program. A menu 
screen will appear as follows: 
 

 
STEP 2 
Click on the "Xplug Control" hyperlink to activate the installation procedure for the 
plug-in program. 
If the above screen is not shown, you can start the installation as follows. 

E 
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1. Click on Start Menu/ Run. 
2. Enter “D:\ActiveX\xpctrl.exe” in the appeared box, where “D” is the letter of your 

CD-ROM drive. 

3. Click on “OK” button. 

STEP 3 
The Welcome screen will appear. Click on the “Next” button to proceed with the 
installation. 
 

 
 

STEP 4 
The License Agreement will appear as below. Read the details carefully and click on 
the “Yes” icon to continue with the installation procedure. 
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STEP 5 
Click on the “Finish” button to complete Setup of the Xplug Control Utility program for 
the Wireless Internet Camera. 
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Appendix F 
Specification 
 

 ICA-100 ICA-100W 

Video Specification 

Resolution 640 x 480 pixel 

Sensor 1/3” color CMOS sensor 

Gain control Automatic 

Exposure Automatic 

White Balance Automatic 

Shutter Electronics 1/60 ~ 1/15000 sec 

Minimum Illumination 2.5lux@F1.4, 3000K color 

Focal Length 6.0 mm 

Aperture f=1.8 

Focus Extent 20 cm - ∞ 

Lens mounting Fixed board lens, CS-mount type 

Image (Video Setting) 

Image compression JPEG 

Frame rate 20fps@CIF, 3fps@VGA 

Compression Rate 
selection 

5 level (Very Low, Low, Medium, High, Very High) 

Frame rate setting 1,5,7,15,20,auto(depends on the video format) 

Video resolution 320x240, 640x480 

Brightness control Range 1- 128 

Contrast control Range 1- 128 

Hue control Range 1- 128 

System Hardware 

LAN Connector One RJ-45 port to connect to 10/100Mbps Ethernet, auto-
sensing 

Wireless LAN - Built-in 802.11b wireless 
LAN module with 2 SMA 
connecter 

Generic I/O Port Four I/O ports, two for input and two for output 

LED Indicator Power LED (Blue) ,LAN Activity LED (Orange) 

F 
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Management 

Communication media 10/100Mbps Ethernet 10/100Mbps Ethernet, 
IEEE 802.11b wireless 

Communication proto-
col 

HTTP, FTP, TCP/IP, UDP, ARP,ICMP, BOOTP, RARP, 
DHCP, PPPoE 

Management Utility Internet Browser, Software Utility 

Utility Support OS Win 98, Win 98 SE, Win 2000, Win Me, Win XP 

Utility Function • Live image viewing 
• Remote management 
• Snap shot 
• Picture recording 
• Motion detection 

Operating environment 

Operating temperature 5 °C~ 50 °C 

Storage temperature -25 °C ~ 50 °C 

Humidity 5% ~ 95% non-condensing 

EMI 

Regulation FCC, CE, VCCI 
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Appendix G 
Glossary of Terms 
 
NUMBERS 
10BASE-T  
10BASE-T is Ethernet over UTP Category III, IV, or V unshielded twisted-pair media. 
100BASE-TX  
The two-pair twisted-media implementation of 100BASE-T is called 100BASE-TX. 
 
A 
Applet  
Applets are small Java programs that can be embedded in an HTML page. The rule at 
the moment is that an applet can only make an Internet connection to the computer 
form which the applet was sent. 
ASCII  
American Standard Code. For Information Interchange, it is the standard method for 
encoding characters as 8-bit sequences of binary numbers, allowing a maximum of 
256 characters. 
ARP  
Address Resolution Protocol. ARP is a protocol that resides at the TCP/IP Internet 
layer which delivers data on the same network by translating an IP address to a physi-
cal address. 
AVI  
Audio Video Interleave, it is a Windows platform audio and video file type, a common 
format for small movies and videos. 
 
B 
BOOTP  
Bootstrap Protocol is an Internet protocol that can automatically configure a network 
device in a diskless workstation to give its own IP address. 
 
C 
Communication  
Communication has four components: sender, receiver, message, and medium. In 
networks, devices and application tasks and processes communicate messages to 
each other over media. They represent the sender and receivers. The data they send 
is the message. The cabling or transmission method they use is the medium. 
Connection  
In networking, two devices establish a connection to communicate with each other. 
 
D 
DHCP  
Dynamic Host Configuration Protocol was developed by Microsoft. It is a protocol for 
assigning dynamic IP addresses to devices on a network. With dynamic addressing, a 
device can have a different IP address every time it connects to the network. In some 
systems, the device's IP address can even change while it is still connected. DHCP 
also supports a mix of static and dynamic IP addresses. This simplifies the task for 
network administrators because the software keeps track of IP addresses rather than 
requiring an administrator to manage the task. This means a new computer can be 
added to a network without the hassle of manually assigning it a unique IP address. 
DHCP allows the specification for the service provided by a router, gateway, or other 

G 
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network device that automatically assigns an IP address to any device that requests 
for it. 
DNS  
Domain Name System is an Internet service that translates domain names into IP 
addresses. Since domain names are alphabetic, they're easier to remember. The 
Internet however, is really based on IP addresses. Every time you use a domain name,  
the DNS will translate the name into the corresponding IP address. For example, the 
domain name www.network_camera.com might translate to 192.167.222.8. 
 
E 
Enterprise network 
An enterprise network consists of collections of networks connected to each other over 
a geographically dispersed area. The enterprise network serves the needs of a widely 
distributed company and operates the company’s mission-critical applications. 
Ethernet  
The most popular LAN communication technology. There are a variety of types of 
Ethernet, including 10 Mbps (traditional Ethernet), 100 Mbps (Fast Ethernet), and 
1,000 Mbps (Gigabit Ethernet). Most Ethernet networks use Category 5 cabling to 
carry information, in the form of electrical signals, between devices. Ethernet is an 
implementation of CSMA/CD that operates in a bus or star topology. 
 
F 
Fast Ethernet  
Fast Ethernet, also called 100BASE-T, operates at 10 or 100Mbps per second over 
UTP, STP, or fiber-optic media. 
Firewall  
Firewall is considered the first line of defense in protecting private information. For 
better security, data can be encrypted. A system designed to prevent unauthorized 
access to or from a private network. Firewalls are frequently used to prevent unauthor-
ized Internet users from accessing private networks connected to the Internet, 
especially Intranets. All messages entering or leaving the intranet pass through the 
firewall, which examines each message and blocks those that do not meet the speci-
fied security criteria. 
 
G 
Gateway  
A gateway links computers that use different data formats together. 
Group  
Groups consist of several user machines that have similar characteristics such as 
being in the same department. 
 
H 
HEX  
Short for hexadecimal. It refers to the base-16 number system, which consists of 16 
unique symbols: the numbers 0 to 9 and the letters A to F. For example, the decimal 
number 15 is represented as F in the hexadecimal numbering system. The hexadeci-
mal system is useful because it can represent every byte (8 bits) as two consecutive 
hexadecimal digits. It is easier for humans to read hexadecimal numbers than binary 
numbers. 
 
I 
Intranet  
This is a private network, inside an organization or company that uses the same soft-
ware you will find on the public Internet. The only difference is that an Intranet is used 

http://www.network_camera.com
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for internal usage only. 
Internet  
The Internet is a globally linked system of computers that are logically connected 
based on the Internet Protocol (IP). The Internet provides different ways to access 
private and public information worldwide. 
Internet address 
To participate in Internet communications and on Internet Protocol-based networks, a 
node must have an Internet address that identifies it to the other nodes. All Internet 
addresses are IP addresses 
IP  
Internet Protocol is the standard that describes the layout of the basic unit of informa-
tion on the Internet (the packet) and also details the numerical addressing format used 
to route the information. Your Internet service provider controls the IP address of any 
device that connects to the Internet. The IP addresses in your network must conform 
to IP addressing rules. In smaller LANs, most people will allow the DHCP function of a 
router or gateway to assign the IP addresses on internal networks. 
IP address  
IP address is a 32-binary digit number that identifies each sender or receiver of infor-
mation which is sent in packets across the Internet. For example 80.80.80.69 is an IP 
address, it acts as the telephone number of Internet. When you “call” that number, 
using any connection methods, you get connected to the computer that “owns” that IP 
address. 
ISP  
Internet Service Provider is a company that maintains a network that is linked to the 
Internet by way of a dedicated communication line. An ISP offers the use of its dedi-
cated communication lines to companies or individuals who can’t afford the high 
monthly cost for a direct connection. 
 
J 
JAVA  
Java is a programming language that is specially designed for writing programs that 
can be safely downloaded to your computer through the Internet without the fear of 
viruses. It is an object-oriented multi-thread programming best for creating applets and 
applications for the Internet, Intranet and other complex, distributed network. 
 
L 
LAN  
Local Area Network is a computer network that spans a relatively small area sharing 
common resources. Most LANs are confined to a single building or group of buildings. 
 
N 
NAT  
Network Address Translator generally applied by a router that makes many different IP 
addresses on an internal network appear to the Internet as a single address. For 
routing messages properly within your network, each device requires a unique IP 
address. But the addresses may not be valid outside your network. NAT solves the 
problem. When devices within your network request information from the Internet, the 
requests are forwarded to the Internet under the router's IP address. NAT distributes 
the responses to the proper IP addresses within your network. 
Network  
A network consists of a collection of two or more devices, people, or components that 
communicate with each other over physical or virtual media. The most common types 
of network are:  

LAN – (local area network): Computers are in close distance to one another. They 
are usually in the same office space, room, or building. 
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WAN – (wide area network): The computers are in different geographic locations 
and are connected by telephone lines or radio waves. 

NWay Protocol  
A network protocol that can automatically negotiate the highest possible transmission 
speed between two devices. 
 
P 
PING  
Packet Internet Groper, a utility used to determine whether a specific IP address is 
accessible. It functions by sending a packet to the specified address and waits for a 
reply. It is primarily used to troubleshoot Internet connections. 
PPPoE  
Point-to-Point Protocol over Ethernet. PPPoE is a specification for connecting the 
users on an Ethernet to the Internet through a common broadband medium, such as 
DSL or cable modem. All the users over the Ethernet share a common connection. 
Protocol  
Communication on the network is governed by sets of rules called protocols. Protocols 
provide the guidelines devices use to communicate with each other, and thus they 
have different functions. Some protocols are responsible for formatting and presenting 
data that will be transferred from file server memory to the file server’s net work 
adapter. Others are responsible for filtering information between networks and 
forwarding data to its destination. Still other protocols dictate how data is transferred 
across the medium, and how servers respond to workstation requests and vice versa. 
Common network protocols responsible for the presentation and formatting of data for 
a network operating system are the Internetwork Packet Exchange (IPX) protocol or 
the Internet Protocol (IP). Protocols that dictate the format of data for transferors the 
medium include tokenpassing and Carrier Sense Multiple Access with Collision Detec-
tion (CSMA/CD), implemented as token-ring, ARCNET, FDDI, or Ethernet. The Router 
Information Protocol (RIP), a part of the Transmission Control Protocol/Internet Proto-
col (TCP/IP) suite, forwards packets from one network to another using the same 
network protocol. 
 
R 
RARP  
Reverse Address Resolution Protocol, a TCP/IP protocol that allows a physical ad-
dress, such as an Ethernet address, to be translated into an IP address. 
RJ-45  
RJ-45 connector is used for Ethernet cable connections. 
Router  
A router is the network software or hardware entity charged with routing packets be-
tween networks. 
 
S 
Server  
It is a simple computer that provides services, such as files accessing or other 
information. 
SMTP  
The Simple Mail Transfer Protocol is used for Internet mail. 
SNMP  
Simple Network Management Protocol. SNMP was designed to provide a common 
foundation for managing network devices. 
Station  
In LANs, a station consists of a device that can communicate data on the network. In 
FDDI, a station includes both physical nodes and addressable logical devices. Work-
stations, single-attach stations, dual-attach stations, and concentrators are FDDI 
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stations. 
Subnet mask  
In TCP/IP, the bits used to create the subnet are called the subnet mask. 
 
T 
TCP/IP  
Transmission Control Protocol/Internet Protocol is a widely used transport protocol that 
connects diverse computers of various transmission methods. It was developed by the 
Department of Defense to connect different computer types and led to the develop-
ment of the Internet. 
Transceiver  
A transceiver joins two network segments together. Transceivers can also be used to 
join a segment that uses one medium to a segment that uses a different medium. On a 
10BASE-5 network, the transceiver connects the network adapter or other network 
device to the medium. Transceivers also can be used on 10BASE-2 or 10BASE-T 
networks to attach devices with AUI ports. 
 
U 
UDP  
The User Datagram Protocol is a connectionless protocol that resides above IP in the 
TCP/IP suite 
ULP  
The upper-layer protocol refers to Application Layer protocols such as FTP,SNMP, and 
SMTP. 
Utility  
It is a program that performs a specific task. 
UTP  
Unshielded twisted-pair. UTP is a form of cable used by all access methods. It consists 
of several pairs of wires enclosed in an unshielded sheath. 
 
W 
WAN  
Wide-Area Network. A wide-area network consists of groups of interconnected com-
puters that are separated by a wide distance and communicate with each other via 
common carrier telecommunication techniques. 
Workgroup  
A workgroup is a group of users who are physically located together and connected to 
the same LAN, or a group of users who are scattered throughout an organization but 
are logically connected by work and are connected to the same network group. 
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